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Introduction
Welcome
Welcome to WxWorx on Water™—software that delivers revolutionary weather capabilities to the marine
industry through the XM WX Satellite Weather service.
WxWorx on Water is one of three mobile weather display products offered by WxWorx, Inc. as a
sophisticated means of displaying and interacting with XM WX Satellite Weather data. WxWorx also
provides software display solutions for Aviation and Ground applications, along with a portable receiver.
Thank you for selecting WxWorx on Water and the XM WX Satellite Weather service. We are committed
to making this the best source of mobile weather available.

Disclaimer
THE SOFTWARE PRODUCT IS PROVIDED "AS IS." ALL OTHER WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE OR OF NON-INFRINGEMENT ARE HEREBY EXCLUDED.
Weather-related data is obtained from various sources and is transmitted to a central collector and
broadcast point. Equipment failure, accidental damage, vandalism, acts of God, and other circumstances
beyond the control of WXWORX, may interrupt service. WXWORX assumes no responsibility for and
END USER releases and discharges WXWORX from any and all liability or damages, whether direct or
indirect, consequential, incidental, express or implied, for predicting actual weather patterns, from the use
or reliance upon any weather data, use of the Products, any WXWORX provided data, or any resultant
injury, death or damage to any person or property there from. To the fullest extent permissible under law,
END USER agrees to release and discharge WXWORX, its directors, officers, agents, employees and
affiliates from any and all liabilities, damages, losses, expenses, demands, claims, suits, or judgments, for
the death of, or bodily injury to any person, and for the loss of, damage to, or destruction of any property in
any manner arising out of the use of the Products by the END USER, its agents, employees or any person
to or for whom END USER may be responsible. In any event, liability for damages attributed to WXWORX
for any claim brought relating to the Products are expressly limited to amounts paid by END USER
hereunder for the product that is the subject of the claim. IN NO EVENT SHALL WXWORX BE LIABLE
FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGE, INCLUDING BUT NOT
LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR OTHER DAMAGES.

Chapter 1: Data/Software Packages and System Requirements
1.1 Pilot vs. Master Mariner
There are three data packages available for the WxWorx on Water program; Pilot and Master Mariner.
The subscription is initially activated and can be changed through XMListener Care (see Section 2.3).
Throughout this manual if the feature is not in one of these packages it will be noted. See the table below
for a summary of the data and the packages they are part of.

XMWX Service Products
High Resolution NEXRAD Radar
High Resolution Radar
Radar Coverage
Precipitation Type (at surface)
Surface Observations
NWS Forecasts
County Warnings
Weather Warnings
City Forecasts
Surface Analysis Weather Maps
Wave Direction (Pacific + Atlantic)
Wave Direction Forecast: 12, 24, 36
Wave Period (Pacific + Atlantic)
Wave Period Forecast: 12, 24, 36
Surface Wind Speed/Direction
Surface Wind Speed/Direction:12, 24, 36
Surface Pressure
Surface Pressure Forecast: 12, 24, 36
Sea Surface Temperature
Wave Height (Pacific + Atlantic)
Wave Height Forecast: 12, 24, 36
Buoy Data
Marine Zone Forecast Coastal
Marine Zone Forecast Offshore
High Seas Forecast
Marine Weather Messages
Winds Aloft
Hurricane Track
Visibility
Visibility Forecast: 12, 24, 36
Severe Weather Storm Tracks
Lightning
Satellite Mosaic
Fish Bytes

XMWX Service Packages
Pilot
Master Mariner
U.S./PR
U.S./PR
Canada
U.S.
U.S./Canada
U.S./PR/Canada
U.S./PR/Canada
U.S.
U.S./Canada
U.S.
U.S.
U.S.
U.S.
Canada
U.S.
U.S.
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
Canada
U.S.
U.S./PR/Canada
U.S./PR/Canada
U.S./PR/Canada
U.S./PR
U.S.
U.S./PR/Canada
U.S./PR/Canada

1.2 Basic vs. Premium
There is a base software package and an optional premium GPS/Mapping upgrade package. The base
package will display a gray background with state lines and does not allow the import of GPS data or
customization of the places database. The premium upgrade adds the topography, allows the import of
GPS data and moving map capabilities, and customization of places.

1.3 System Requirements
The WxWorx software can be viewed using a variety of devices including tablet and laptop PC's. The
hardware should meet or exceed the suggested hardware requirements for optimum usability, and the
operating system must be running Windows 2000, Windows XP, or XP Tablet. It is also designed for use
with touch-screen systems. The capability of WxWorx gives you current graphical and textual weather
information viewable from anywhere in the continental United States and its coastal waters.
Suggested Hardware Requirements:
800 MHZ Pentium-Class Processor
512 MB of RAM
350 MB of hard-disk space
CD-ROM Drive for software installation
Available USB port

Chapter 2: Installation and Setup
WxWorx on Water is a weather information resource and requires auxiliary hardware for data display and
reception. To ensure that the complete system is fully operational you must make certain that the following
steps have been followed:
Complete



hardware installation*
WxWorx software
Activate subscription through XM Listener Care Center
Read this manual to learn how best to use the system
Install

2.1 Complete Hardware Installation
*Hardware components consist of antenna, cabling, receiver, power supply and/or display device.
Hardware installation information is covered by the appropriate documentation. Follow those
instructions; however, it is the owner’s responsibility to see that all certification aspects are covered.

2.2 Installing the WxWorx Software
Insert the application CD-ROM into your CD-ROM Drive. With Autorun enabled, the installer will
automatically launch. Follow the on-screen instructions to install the application. If this does not happen,
browse to the CD and open it. Look for the Setup file and double click on it to launch the installer. If your
install ever becomes corrupt, it can be corrected using the Install CD and the repair utility that is part of the
uninstall process. If the file becomes corrupt, launch the Uninstaller from the Start menu and select the
repair option.
Installing the Receiver Drivers
There are two device drivers that need to be installed to make the application work with your receiver.
After installing the application software, connect the power, antenna, and USB cable to the receiver (follow
the instructions provided with the receiver). Connect the receiver to your computer's USB port. Windows
will recognize the receiver and install the drivers.
Identifying the Serial Port
You can identify the serial port that your receiver is connected to by looking in the Device Manager. To get
to the Device Manager either right-click on the My Computer icon and select properties, click on the
Hardware tab, and then click on Device Manager or open the Control Panel from the Start menu, select
the System panel, click on the Hardware tab, and then click on Device Manager. Once in the Device
Manager click on the + sign beside the Ports (COM &LPT). Look for the USB to serial port device and
then the COM port number in brackets. This indicates that the receiver is installed correctly in the system
and the port Windows has assigned to it. The COM port setting will depend on the device number chosen
by the driver and operating system. Typically, it will be higher than COM2.
XmLink Configuration Settings
XmLink is the software program that communicates with your radio and provides the weather data to your
display application. For a complete description of XMLink, see Section 3.0. In order to activate your
receiver, first launch XmLink from the Windows Start menu, WxWorx folder. The first time the application
runs it will detect the COM port the receiver is connected to. Select yes to power up the radio. If you wish
to manually set the COM port, open the communications settings dialog. From the port pull-down menu,

select the correct port for your receiver. Ensure the baud rate is 38,400 bps. NOTE: The baud rate is
configured at the factory for 38,400 bps and cannot be changed through this interface.
The radio serial number will appear in the window. This number should match the one on the bottom of
the receiver and on the box your receiver came in, and will be used in the Activation step that follows. The
software will automatically enter activation mode the first time it is launched. Do not click the “Done”
button in activation mode until the completion of Section 2.3, and when the service level you
signed up for is shown in the “Service Level” window. If you do not wish to activate at this time, then
use the exit button to shut down XmLink.

2.3 Activating an XMWX Satellite Weather-Ready Receiver
To

activate service call (800) 985-9200.

Please

advise your Listener Care Representative that you are activating an XMWX Satellite WeatherReady Receiver and provide the 8-digit radio ID located on the bottom of the radio or the outside of the
packing box. The Listener Care Representative will ask for billing information and discuss the types of
weather data packages that are available for subscription.
Activation Instructions
Approximately 5 minutes after your call with the Listener Care Center XM will broadcast an activation
signal and continue to broadcast the activation message for 36 hours. Please ensure your antenna has a
clear line of sight to the sky. Please leave your receiver on until the “Service Level” displayed in the
XmLink activation mode window agrees with the level you requested. This can take up to an hour. You
can now start the WxWorx program and enjoy the WxWorx experience. If an hour has passed and you
are not receiving data services, please call the Listener Care Center at (800) 985-9200.
Refresh Instructions
If you find your receiver had been deactivated then a refresh can be obtained over the internet by going to
www.xmradio.com/refresh and following the instructions or by calling Listener Care at (800) 985 9200.
Make sure you have your 8 digit receiver ID ready.

Chapter 3: XmLink (Vers. 1.0.66R)
XmLink's menus are made up of File, Tools and Help.

File - Exit Command
If you try to exit the program, a prompt will ask you to confirm you want to exit. NOTE: when you exit
from the display program, XmLink does not shut down. You can leave this program running in your
system tray so that your weather data is always current when connected to your receiver even if the
display software is not running. You must manually close this program. You may choose not to see the
prompt again by selecting the check box.
Tools - Counters Command
This displays error counters. There are three
types: Receive, CRC, and Other. In most cases,
these are caused by signal problems. With good
reception, you should not expect to see more
than ten errors a day, and often none. The Reset
button zeros the error counters. The Refresh
updates the counters.
Tools - Communication Settings Command
This command is used to specify the type of
communication, either Serial Port Mode or Network Mode.
To change modes select “Serial Port Mode” or “Network Mode” in the bottom left of the Communications
window.

Serial Port Mode is compatible with the Portable Unit for direct connections to the RS-232, Powered USB
and Bluetooth® interface modules. Serial Port Mode is also compatible with the Certified Unit. Consult
your receiver manual for specific power requirements. In Serial Port mode the communications port (COM
port) and data rate can be set. The radio contains jumper settings internally to set the data rate. For the
Portable Unit the factory setting is 38400 bits per second (bps) while the Certified Unit is factory set to
115,200 bps. The COM port setting will depend on the device number chosen by the driver and operating
system. Typically, it will be higher than COM2. The COM port field pull-down button will show the available
COM ports. This command is also entered on program startup if the currently configured COM port is
invalid.

Network Mode is compatible with WxTunes™ software and connections the Portable Unit for Power over
Ethernet (PoE) interface module. Consult your receiver manual for specific power requirements. There
are two types of setups that can be achieved with the network mode, either an Indirect Ethernet
Connection to a Hub, Switch or Router or Direct Ethernet Connection to the PC.
Indirect Ethernet Connection via Hub, Switch or Router
To setup Ethernet Communication using a Hub, Switch or Router, select “Scan for MAC Address,” this
allows for searching of the radio on the network that the computer and receiver are connected to. The
MAC pattern does not need to be changed. The Start scan address states IP address that the scan will
start at. The Lowest scan address is the smallest IP address that will be scanned. The Highest scan
address is the largest IP address that will be searched for the radio connection. Example settings would
be:
Start scan address: 192.168.1.0
Lowest Scan address: 192.168.1.0
Highest Scan address: 192.168.1.255
The TCP/IP port is what XmLink will use to communicate with other software programs. A setting of 20001
will communicate directly with the receiver. 30001 will utilize XMGateway (in support of WxTunes™
software)

Advanced Indirect Ethernet Connections
This section should only be used for advanced non-typical network installations, consult your network
administrator.
If the network does not use the default non-routable “192.168.1.***” pattern, to find the address:
I. Select: Start > Run
II. Type cmd and select OK
III. Type ipconfig and press the enter key
IV. In the list that is created will list the computer IP Address.
V. Once you have copied down the computer IP Address, Type exit and press the enter key
VI. For Start scan address, Lowest Scan Address and Highest Scan address, use the numeric values
found in step 4 for the first three blocks then “0” or “255” accordingly.
a. IE: if step 4 returns an IP address of: 67.234.18.71, for:
i. Start scan address: 67.234.18.0
ii. Lowest scan address: 67.234.18.0
iii. Highest scan address: 67.234.18.255
After setting the Network Communications, now connect the Ethernet receiver’s network cable to the hub,
switch or router.
A message window will open asking you to confirm
changes to Network mode. Select “Yes” for Change
to Network Mode.

A scan will now start to find the Ethernet Module receiver. Providing the network, subnet and computer
are all properly configured, communications with the receiver should be established. If the receiver isn’t
discovered after the scan is complete, recycle the power to the receiver (or Ethernet port connection for
powered over Ethernet) to get an IP address assignment.

Direct Ethernet Connection to computer
To setup Ethernet communications with a direct connection to a computer from the receiver or if you
intend to configure communications without a network device, the receiver is capable of using a static IP
scheme. The computer should be configured to be on a similar, but not identical IP address as the
receiver’s fixed static IP address of 192.168.0.70.
NOTE: Before proceeding with these steps please ensure the computer has another method for
network (Ethernet, Internet, Wireless, USB, or Bluetooth) communications or that the intent is not
to communicate with other computers.

To change or to set your IP address to a static IP
similar to the receiver, open the Local Area
Connection Settings. Select Start->Connect to>Show all connections in the Windows start bar.

Select Local Area Connection -> Change settings of this
connection under Network Tasks on the left pane.

From Local Area Connection Properties, select “Internet
Protocol (TCP/IP)” -> Properties

Select “Use the following IP address:”
IP address: 192.168.0.*** (*** = any number 1-255, except 70)
Subnet mask: 255.255.255.0
Default Gateway: blank
Select OK

In the Set Communications Port window, select Network
Mode in the bottom left of the window.

In the Set Network Communications window select Set
Specific Address and enter the static IP address of
192.168.0.70
TCP/IP port:
Select 20001 to communicate directly with the receiver
Select 30001 to utilize XMGateway (In support of
WxTunes™)
Select OK

This will connect with the receiver using the Ethernet
Module. If the receiver isn’t discovered within a few
minutes, recycle the power to the receiver (or connection
for PoE).

Tools - Receive history Command
This command displays a list of received data products. Each possible product is listed even if the service
level does not permit reception of that product. There may also be "unknown" products listed when
test/diagnostic messages are received. Clicking on a product will display a list of times the product was
received over the last hour. The number of products received will depend on the data package that has
been subscribed to. In the picture shown below the receiver is activated for Aviator.

Tools - Activation mode Command
This command is used whenever the radio is first
activated or the subscription service level is
changed. When a new radio is first started, this
command is entered at startup. This command
should be active when calling Customer Care to
subscribe and activate the radio. The current
service level is displayed. When the desired
service level is reached, activation mode may be
exited by clicking “Done”. This command can be
run at any time to display the current level. Up to
one hour should be allowed for the current level to
be determined. However, weather data is not
processed while in activation mode. If you are
not ready to activate your receiver, you can exit
XmLink from this command dialog. The boxes that
get checked in this window are set by the activation
level and are not user-configurable. If you have
problems with activation, you may be asked for
information displayed in this window. This
command is used whenever the radio is first
activated or the subscription service level is
changed.
Note: the number of boxes checked depends on the data subcription (See Section 1.1).
Tools - Time Synchronization Command

Use this command to keep the computer clock accurate based on continuous time broadcasts via XM
Radio. In the case where other time-correction services are available, this can be turned off or placed in
monitor mode. In monitor mode, the time
received from XM is compared to the
system time and a message is displayed if
they differ by an adjustable amount.
When another time source is always
available, it should be used instead of
XmLink's time service. Although the XM
clock is highly reliable, no attempt is made
by XmLink to approach sub-second
precision. However, the built in service is
ideal when there is no other time source
available and it will keep the computer
clock within a couple of seconds of actual
time.
Select one of the three modes: no time
checking; time monitor; or time correction.
Several parameters can be changed, and
the default parameters can be restored with
the "Restore Defaults" button.
The maximum adjustment in 100 seconds
parameter can be set as high as 15.
XmLink adjusts the clock such that a
second is never lost, only shortened or
stretched. However, a smaller value should
be used since some applications may be doing critical timing based on time of day.
The received time latency should always be set to 10 for the current XM channel.
Help - Contents Command
Displays the help file. Your default browser is used and, if desired, the URL (of type file:) can be added to
your bookmarks.
Help - About Command
Displays XmLink version number.
How to find XmLink when it is running
When XmLink starts, and when it is minimized, its task bar button is removed and only the double headed
arrow icon is shown in the system tray (near the time display). To display the XmLink main screen, either
double-click on the icon or right click on it and pick "Show Console" from the menu.
When XmLink is actively receiving data from the radio, the LED icon in the WxWorx software blinks a
bright green. Clicking on this icon or the XmLink button will bring XmLink to the forefront.
Radio Serial Number and Signal Quality
The main window of XmLink shows the Radio Serial Number as read directly from the XMWX Receiver.
This number should be identical to the serial number on your receiver. This number will only change if a
different receiver is attached or if there is a problem with communications with the receiver in which case
no serial number will be shown.

Also shown in the main window of XmLink is the signal quality data that is periodically delivered by the
radio. In addition to the general status, the Bit Error Rate (BER) for both satellites and any ground repeater
is shown. Low values of BER indicate good reception. When a very high BER is associated with a source,
it is shown as >999, which essentially means no signal.
It is not necessary to receive data from both satellites. Excellent performance can be obtained from only
one.
The signal quality is also recorded in the log at the top of every minute.
Log Display
The main window shows a running log of XmLink activities and exceptional events. Only a few hundred
lines are buffered in the log window display. Full logs are stored in text files named "xmlinkyyyymmdd.log", where yyyymmdd is replaced by year, month and day. A new file is created every day and
old ones are deleted after four days. The default location for the log files is "C:\Program Files\Common
Files\XmLink".
Typical log lines are:
Received xx yyyy (zzzz) - indicates product number xx was received. The transmitted product size is
yyyy bytes and zzzz is the product name.
Created yyyy - yyyy is the name of a product file that was created. By default, these are created in
"C:\Program Files\Common Files\XmLink\data". Many are in binary format, but the files in the "text" folder
can be read with notepad (as can the buoy files in the worldwinds folder). In most cases, a "Received" log
line is followed by a "Created" log line. This is not always the case, since XmLink can detect that certain
products have unchanged data and therefore does not write a new file.
Signal: qqqq llll S1 nnnn S2 nnnn T nnnn - Every minute, the signal quality qqqq and the lock status llll
is logged. Also logged are the BERs for the satellites (S1 and S2) and any ground repeater. Note that
unlike the BER shown on the main window, these can have values exceeding 999.
Last sss seconds: nnnnn bytes, bbb bps
Total mm:ss min: nnnnn bytes, bbb bps
AppPackets aaaa (Last 600 secs: aaa packets, nnnn bytes)
RxErrs eee CrcErrs eee OtherErrs eee (Last 600 secs: eee eee eee)
These lines are logged every 10 minutes (600 seconds). They contain the number of bytes received, the
effective data rate and error counters.
CBM_ERROR_IND err=FF,FF, msg= FRAME size - This message is displayed when there is a
communication problem not caused by signal quality. It should be self correcting, although often a burst of
log messages is generated.
RxErr: Sync in message nn - This and similar error messages typically indicate that a block of data was
lost due to reception problems. nn is the product number that was affected.
Unpack yyyy data: error nn - an error was found when attempting to uncompress a received product
yyyy. Errors 51 and 52 are CRC errors and typically caused by poor reception.
Sending Power Up to Radio - this message appears when XmLink attempts to reinitialize the radio. It
appears normally at startup and at other times, but repeated listing indicates that there is a problem
communicating with the radio.
[XMweather] Connect: 127.0.0.1 - this and similar messages are logs of interprocess communication
between XmLink and the display application.

Chapter 4: Operational Description
WxWorx on Water is a software display package specifically designed as an on-the-water weather
information system. It continuously and automatically receives updates, and displays weather data utilizing
an intuitive user interface that makes data easy to access and allows for quick visual interpretation.
WxWorx on Water provides comprehensive real-time weather information in both textual and graphical
formats for ready reference. Easy commands enable you to create any view of the weather desired as the
data and mapping elements are flexible and not composed of pre-saved picture components.
The Base system consists of:
Standard

mapping: a gray base map of the continental United States, state lines, ocean water, and
airport outlines that will appear when the image is zoomed to below a 100-mile viewing radius
The map manipulation features. (See Section 4.3)
The weather display features. (See Section 4.4)
Other features can be purchased and are packaged as follows:
Mapping and GPS Functions (Section 4.5)
Contact WxWorx at (321) 751-9202 or visit www.wxworx.com for additional details on these packages.

4.0 Starting the WxWorx On Water Program
At the completion of your WxWorx software installation, a WxWorx on Water icon will automatically be
placed on the desktop of your computer. The software can be launched in two modes, normal mode,
during which current weather data is downloaded from the satellites using the satellite receiver, and demo
mode, which allows a user to look at data sets from earlier events and configure their software without
being connected to a satellite receiver.
4.0.1 Normal Mode
To launch the application in Normal mode follow the
instructions for connecting your receiver to your
computer and then simply double click on the
desktop shortcut to launch the application. See the
troubleshooting guide in Chapter 5 if the launch
does not occur.
Each time the software is started you will be
presented with a window for you to select the
display resolution you wish to use. Your choice will
remain as the default until a different resolution is
chosen. If you check the box at the bottom, this
screen will not appear again (See end of paragraph
to get this choice back). The software will then
launch the XmLink application, purge the data files
and initiate connection to your receiver. Once the
connection is established and the serial number is
read from the receiver, you will be presented with
the WxWorx on Water license and user understanding agreement. You must select the “Accept” option in
order for the WxWorx on Water program to launch. A printable copy of this agreement is accessible under
the Help main menu and in this manual; see Disclaimer in Table of Contents. Clicking the “Do Not Accept”
button will stop the software from launching and uncheck the “Always use this resolution” checkbox if it
has been selected.

Upon accepting the Disclaimer the
main WxWorx on Water display
window will then be loaded. Depending
on your hardware configuration this
may take a short while as all of the
mapping data is loaded. Note after the
initial resolution selection and
acceptance of the disclaimer these
two windows will disappear
automatically after a time delay of ~5
and ~10 seconds respectively if no
other mouse movements are detected
by the system.
4.0.2 Demo Mode
To launch the application in Demo mode you must have a demo data set loaded on your computer (see
the wxworx.com website to download data sets if this option is not present on your system) and no
satellite receiver connected. Double click on the desktop shortcut to launch the application. Select the
resolution you wish to use and when the Xmlink application launches just exit the application. Depending
on your configuration you may be presented with a communications error and a request to setup the
communications, select No at this point to exit
the application. After a short time the ERROR
window shown will appear.
Note: if you do not have a demo set on your
computer the demo option will not be available
to you.

Select the demo button and if more than one data set is
present you will be allowed to choose which dataset you
want to load. Once you have chosen the data set and
pressed ok a status window indicating the progress of the
data load will appear. During this load any current weather
data in your data directories will be deleted and replaced
with the specified data set.

Once the dataset has been fully loaded the application will launch normally and you will have access to all
the features. Any changes you make to layers or any settable functions will be saved for subsequent
launches.

4.1 Interface and Main Menus
4.1.1 Main Menus

This tool bar provides access to the main pull-down lists, referred to as Main Menus in this guide, which
allow you to access advanced functions of your system and are located at the top of the screen. Clicking a
menu title opens a pull-down list. To activate a particular function, place the cursor over your choice on the
menu, and click the desired choice.
The only command in the File main menu is Exit. You should only use this command when you wish to
close the WxWorx program. Note that XmLink will continue to run.
The View main menu contains options related to storing and displaying map
parameters for a specific location (known as a view). These parameters enable you to
customize two views for quick reference to specific areas. View 1 is set to a nationwide
view and cannot be changed.
Print captures the current view and prints it from your computer's associated printer
(only if your computer is connected to a printer).
The Load View and Save View commands allow you to store and recall up to two
unique views, as described in Section 4.2.1.
The Options main menu allows you to
activate or deactivate features that
provide on-screen information.
The Status Bar command allows you
to activate/deactivate the status bar
which provides system status
information. The status bar is
described in Section 4.2.2.
The Legends submenu contains
toggle commands for several onscreen dialogs that provide information
for various data features.
The Radar Legend command defines the colors for standard precipitation (see Section 4.4.1 for
details).
The Radar Legend w/snow command defines the colors for all three precipitation types shown
(precipitation, mixed and snow).
The Sea Surface Temps Legend defines the temperatures associated with the display colors.
The Metar Legend command defines color codes and conditions from METAR reporting stations
(see Section 4.4.7).
The Strike Legend command defines the colors of lightning strike information (see Section
4.4.6).

The Tropical Legend details types of tropical storms (see Section 4.4.5)
The Warnings Legend command provides color-coded National Weather Service warning
information (see Section 4.4.4).
The Wave Heights Legend defines the heights associated with the display colors.
The Wind Legend command details wind barb information (see Section 4.4.12).
All of the legends and marquees that can appear on the map are movable. This means that you can click
on them, hold the mouse button down, and drag the legend or marquee to a spot on the screen where it is
out of the way. Marquees disappear when you click a blank area on the map, but you must click on the
close button (X) in the upper-right corner of a legend to remove it. You can also toggle them off on the
main menu.
The Storm SCITs command allows you to activate/deactivate the display of Storm Cell Information and
Tracking squares (see Section 4.4.17 for details).
The Warning polygons command allows you to activate/deactivate the display of storm based warning
polygons (see Section 4.4.4 for details).
The Virtual Buoys command allows you to activate/deactivate the ability to query Virtual Buoys.
The Sound command allows you to activate/deactivate the use of a customized sound when National
Weather Service (NWS) warnings are processed by the system (see Section 4.4.4 for details).
The Always on Top command when checked forces the operating system to keep the display application
on top of all other applications including the task bar.
The Map button toggles topo command, when checked, allows you to switch topography data on and off
with the Mapping button (this feature is optional and is described in Section 4.5.1). When unchecked, only
the place names will toggle with the Mapping button.
The Misc main menu contains four commands.
The Small Popup command will create a small floating map window (320 x 240
pixels) that will remain on top of other applications.
The Full Screen command will make the map display fill the full screen. In this
mode you do not have access to the buttons or menus. The display should be set to show the features
you want before selecting this mode. You can also access this mode by clicking on the right half of the
WxWorx on Water logo.
The Debug Window command is intended for Customer Care personnel and provides details about
actions that WxWorx performs in the background, and is intended for use when diagnosing possible
causes of any problems that might arise with the system.

The Setup main menu contains submenus that allow you to configure several underlying features of
WxWorx.
The GPS command allows you to configure the display of your GPS interface
for display of the externally supplied GPS data (see Section 4.5.3).
The Places Database command allows you to configure parameters for the
place names that appear when the Mapping button (described in Section 4.5.1)
is activated. The Places Database is only usable with the optional Mapping
upgrade and is described in Section 4.5.2.
The Metar Database command allows you to set the viewable range at which
the NWS reporting METAR station markers appear when the Weather button is
activated (described in Section 4.4.7).
The Configure Counties command allows you to assign which counties
display NWS warnings. See Section 4.2.4 for details on this menu, and Section
4.4.4 for details on NWS warnings.
The Map Layers command brings up the Map
layer editor menu, which allows you to set
both the minimum and maximum range that a
specified layer will appear. The layers with (*)
beside them cannot be changed. If you have
only a Base package then some of these
layers will not be visible at any time. Click on
the Reset default for all layers button to set
the values back to the factory defaults.
The Units command allows you to set the type of units
of measurements; English, metric, or the default that
the WxWorx display will use. See Section 4.2.5 for
details.
The Loop command brings up the Loop Settings
dialog. The frequency (in seconds) is the time between
each loop. The Number of frames is how many images
will be used for the loop, maximum of two-hour loop for
any product (24 frames). Note: the loop function is very
processor intensive.
The Fish command opens the Fish Setup menu,
which lets you control the types of fish that appear in icons when the Fish Forecast button is activated.
See section 4.4.16 for details.
The Fixed Range Rings command allows you to set static rings around a location for distance gauging.
The U.S. Radar, Canada Radar and Puerto Rico Radar commands are on/off display toggles for each
radar product for either the US, Canada or Puerto Rico.

The Help main menu contains three submenus: About, which displays the program's version date, View
Disclaimer, which displays the WxWorx disclaimer, and View Manual which will bring up the User’s
Guide in pdf format.

4.1.2 Radio Reception Indicator and Status Bar

The WxWorx logo area contains several important features. The first is quick
access to Full Screen Mode, which you can enter by clicking on the right half of the WxWorx on Water
logo.
The second feature is the set of green bars below the logo, which is the data reception indicator. If your
radio is not receiving data, all but the smallest bar will disappear and the remaining bar will turn red. At
that point, you should open the XmLink window either by clicking on the bars, the left half of the logo or by
clicking on the XmLink button to see whether your radio reception has deteriorated.
The Status Bar is located beneath the map window. Within this bar you will see information about system
processes, including the current View radius (which is half the width of the area currently displayed on the
map), the zoom range when using the magnifying glass tool (see Section 4.3.3) and details on NWS
warnings when clicking on a filled county (see Section 4.4.4).
4.1.3 Button Operation
The buttons around the map area allow single-click activation of their respective features. The view
manipulation buttons (which are described below) are activated by clicking a button and deactivated in the
same manner.
Normally, inactive buttons are blue and activated buttons are green. The exception is if the product has
not yet arrived or has been missed several times. If that is the case, the button will turn red. Additionally,
the Warnings button will flash orange when new warnings are processed by the system for counties
configured to display warnings. Simply move the mouse quickly back and forth over the warning button to
have it stop flashing orange.

4.2 Customizing Your System
Before you begin using WxWorx, there are a number of functions that you might want to customize in
order for you to receive information from the system in the manner that you desire.
4.2.1 Saving and Loading Views
The View main menu allows you to save two map positions (views) so you can quickly move to a preset
view when the need arises. For example, you may find yourself frequently zooming to a certain area of the
United States in order to get a closer look at a route that you routinely fly. View 1 is a preset nationwide
view and cannot be customized. When you select Save View 2 from the View main menu, the computer
saves the view's radius (as shown in the Status Bar) and its latitude and longitude as View 2. At any time
afterwards, when you select Load View 2 your view will automatically move to the radius and
latitude/longitude that you have previously saved as View 2. If at some point you wish to save a different

view as View 2, simply select the Save View 2 command to overwrite the previously saved view with your
newly selected view. The Save View 3 and Load View 3 commands work together for saving and viewing
a second view in the same manner. A preset view will make current weather information available in the
view you select; it does not display older data.
4.2.2 Toggling the Status Bar
This Status Bar (located below the map) provides information about system processes, including the
current View radius (which is the distance from the center of the view area to the top of the screen), the
zoom range when using the magnifying glass tool (see Section 4.3.2) and details on NWS warnings when
clicking on a filled county (see Section 4.4.4). If you deselect the Status Bar in the Options main menu
your system will toggle off the display of this information. You will notice that the check next to the
command disappears. You can re-enable the Status Bar by selecting the Status Bar command again.
The check will appear next to the command again.
4.2.3 Editing METAR Show Ranges
The Metar Database option under the Setup main menu allows you to adjust the Show Range (View
radius at which a METAR location will appear) for your METARs (which appear when you click the
Weather button; (see Section 4.4.7 for details).
To begin, select the Metar Database submenu under
the Setup menu to open the Select State menu.
Then select a state and click OK to open the state's
METAR list. Find the METAR location that you wish to
edit in the list, click on it to highlight it, and click the
Edit button to open the Edit Metar menu.
The only parameter you can change is the METAR's
show range. Enter the range (in miles) at which you
wish the METAR to appear, and then click OK. Click
Save to save your changes. When you are finished
editing METARs, click the Close (X) button in the
upper-right corner to close the menu.
4.2.4 Configuring
Counties to Receive
Warnings
Some users prefer to
receive NWS warnings
(which you can display
with the Warnings
button; see Section 4.4.4
for details) for a specific
area rather than across
the whole United States.
The Activate Counties
feature, accessible with
the Configure Counties
submenu under the
Setup main menu,
allows you to identify
individual counties that

will or will not display warnings.
The textbox labeled Source Folder allows you to configure the folder on your computer where the
program looks for county files. Do not change this path unless directed to do so by customer care.
The large field on the left side of the menu contains the counties in the selected state currently configured
to display warnings, while the field on the right side contains the counties currently configured to not
display warnings. Only one state at a time displays its counties in the fields. To switch states, select the
desired state from the pull-down list above the right-hand field.
To configure a county to begin displaying warnings, click it in the right-hand field, and then click the leftpointing arrow between the fields to move it to the left-hand field. To configure a county to cease
displaying warnings, click on it in the left-hand field, and then click the right-pointing arrow to move it to the
right-hand field.
You can select all of the counties in a field at once by clicking the button above the field. To select all of
the counties in a state able to receive warnings, click the Set All button, and then click the left-pointing
arrow. To make all of the counties in a state cease notifying you of warnings, click the Del All button, and
then click the right-pointing arrow.
You can set all the counties in the United States to display warnings by clicking the Include All Counties
in the U.S. button. Similarly, you can set all the counties in the United States to cease displaying warnings
by clicking the Remove All Counties in the U.S. button.
When you are done configuring counties, click the Exit button to close the menu. You must close your
WxWorx program and restart it from the desktop in order for the changes you have made to take
effect.
4.2.5 Switching Between Measurement Standards
The Units submenu under the Setup main menu opens the Setup Units menu, which allows you to
choose between using English measurements or metric measurements when displaying data: for
example, choosing between displaying temperature in Fahrenheit or Celsius. The Default Units option
causes the system to use the most appropriate unit based on the context of the measurement.
4.2.6 Checking your Radio Reception Status - XmLink
Access the XmLink program by clicking on the XmLink button or the green colored bars
below the logo, which is a data reception indicator. If either this indicator or the Xmlink button
turns red, there is a problem with your data reception.
When you are finished viewing the Xmlink window, you should minimize it by clicking the minimize
(underscore) button in the upper-right corner of the menu. Do not close the menu by clicking the Close
(X) button or using the File > Exit command unless you are also closing the WxWorx program, as
this will cause your data stream to disconnect.

4.3 Using the Map View Manipulation Buttons
4.3.1 Zooming In and Out on the Map
Clicking the In button zooms in on the map to half the current View radius. You can do this
many times in a row, to a minimum radius of about 0.1 miles.
Clicking the Out button zooms out on the map to double the current View radius. You can do
this many times in a row, to a maximum radius of 1,500 miles.

4.3.2 Panning on the Map
The Pan button allows you to shift the map to a new area without changing the View radius.
Click the Pan button to activate the feature, and then move the cursor (which changes to four
arrows) to the center of the location you wish the map to move to. Click on the map and it
redraw with your selected point in the center of the new.
4.3.3 Zooming to a Selected Area
The magnifying glass button also allows you to zoom into the map for a closer look at places
of interest. Click on
the button to
activate the feature,
and then move the cursor (which
changes to a magnifying glass)
to the area of interest. Click the
mouse and hold on the center
point of the desired new view. As
you move the cursor, a red
rectangular box shows the
boundaries of your new zoom
area. The new View radius in
miles appears in the Status Bar.
Release the mouse button at the
desired range. The system
automatically redraws the map
to your specifications.
If you perform a right click on the
magnifying glass button, the
View radius doubles, in the
same manner as the Out button.
4.3.4 Resetting the Map Position
The Reset button moves the view to a 1,500-mile view radius, centered on the whole United
States, removes all currently displaying data, and also causes SCIT markers to appear (see
Section 4.4.17 for details).

4.3.4 Checking Sunrise, Sunset times and Day Length
The Sunrise Sunset button allows for display of the Sunrise, Sunset and Day Length times
in the Status Bar. Data is displayed based on cursor position.

4.4 Using the Weather Display Features
The Radar, Loop, County Warnings, Tropical, Strikes, Weather, City Forecast, Satellite, Fronts,
Visibility, Waves, Surface, Marine Zones Forecast, Canadian Messages and Fish Forecast buttons
as well as the Storm SCITs command on the Options main menu allow you to display various weather
products and reports.
4.4.1 Displaying Radar Reflectivity Data
Clicking on the
Radar button
displays the radar
reflectivity. This
display is
composed of a composite of all
the active NWS radars across the
United States, as well as data for
Canada provided by Environment
Canada. It provides 2Km
resolution of radar data,
beginning with 10 dBZ reflectivity,
increasing to 55 dBZ.
The accompanying legend can be
used to judge the relative
reflectivity in an area. You can
move the legend to a convenient
place on the screen by clicking
and dragging on it. The radar
reflectivity data indicates strength
in seven colors. Each color correlates to the strength of the radar return and provides a color-coded
overview of the reflectivity in a certain area. The colors are defined below.
dBZ 10 < 20 < 30 < 40 < 45 < 50 < 55<=

While viewing radar reflectivity you have the additional capability to identify the strength of the radar return
on the mapping display through an on-screen query mode. Click on a specific color to identify its dBZ
value.
During the winter season, legends for snow and mixed precipitation can also be used. Simply select Snow
or Mixed from the Options > Legends > Radar Legend w/ snow.

4.4.2 Displaying Current Radar Operational Status
Double-clicking
on the Radar
button, or
clicking the
Radar button when the radar
reflectivity is showing,
switches the display to show
the operational status of the
radars on the network.
This is not radar data; it is
simply a tool that highlights
any particular radar station
currently in operation. You
can use this display to check
whether the radar station in a
specific location is generating
data. The actual position of the
radars in the network is
indicated by the radars' three-letter designations.
4.4.3 Animating Radar Reflectivity Data
The Loop button will animate the Radar or Satellite data. However it will only loop one of
these products at any time. When sufficient data is available, the loop will animate the
last X frames ingested for each product. The number of frames is set from the Loop
function under the Setup menu (see section 4.1.1). This allows you to see the most
recent weather trends at a glance. The display will allow you to stack these two products
on the display with Satellite at the lowest level and Radar on top. The Loop button precedence is Radar
and then Satellite. This means that if both products are turned on, and Loop is selected then Satellite will
disappear and the Radar button will activate and loop. To loop the Satellite data you must select only the
Satellite product and the Loop button. If neither product is active when you select the Loop button, the
Radar button will activate and show a loop of radar reflectivity. Note: the loop function is very processor
intensive.

4.4.4 Displaying National Weather Service Warnings
The County Warnings
button allows you to
display National
Weather Service
warnings for floods, flash floods,
thunderstorms and tornadoes in the
appropriate locations on your map.
Before you can receive warnings for
an area, you must ensure that you
have configured the affected counties
to display warnings (see Section 4.2.4
for details).
When warnings come in, the warnings
button will flash orange, and a sound
will play if you have the Sound option
checked in the Options main menu.
The warnings appear on the map as
small colored boxes. Light gray boxes indicate flood warnings, blue boxes indicate flash flood warnings,
yellow boxes indicate thunderstorm warnings, and red boxes indicate tornado warnings. You can review
these colors in the Warnings Legend, which is accessible through the Options main menu under the
Legends submenu.
Polygon Warnings are displayed when the option is
checked in the Options main menu.
If you have purchased the optional mapping upgrade, the
counties affected by warnings will fill with the appropriate
color when the Mapping button is activated (and when the
View radius is small enough to allow county lines to appear).
You can click on a filled county to display details about the
warning in the Status Bar.
4.4.5 Displaying Hurricane, Tropical Storm and Tropical
Depression Markers (Master Mariner Only)
The Tropical button allows you to track the movement
of storms that are classified as Hurricanes, Tropical
Storms or Tropical Depressions. A Hurricane has a wind
speed of over 74 knots, a Tropical Storm has a wind
speed between 74 and 35 knots, and a Tropical Depression has a wind
speed of less than 35 knots. Each of these storm types is designated
by an icon, which you can review using the Tropical Legend from the
Legends submenu under the Options main menu.

When you click the Tropical button, the system will scan for
storms designated as hurricanes, tropical storms, or tropical
depressions. If none are found, a message box will pop up

which indicates that the system did not detect any of those types of storms within the boundaries of the
data. If a storm is detected, it will appear as a series of icons showing its position beginning with its
observed position and continuing with its forecasted positions. You can click one of the icons to display a
movable marquee, which provides details about the storm's behavior at the time that the
observation/forecast was made. This includes the storm's latitude and longitude, the surface pressure, the
average wind speed (with gusts in parentheses), its movement (direction and speed), and the distance
from the storm center where winds of a certain speed are expected.
4.4.6 Displaying Lightning Strikes (Master Mariner Only)
The Strikes
button toggles
the display of
recent cloud to
ground lightning strikes. These
strikes continually flash while
they are active.
White-colored strikes are less
than five minutes old, yellowcolored strikes are between
five and ten minutes old, and
orange-colored strikes are
between ten and fifteen
minutes old. You can use the
Strike Legend as a reference
to these time frames.

4.4.7 Displaying NWS
Weather Information

The Obs/Buoy button allows
you to view METAR and
buoy data. METAR data is
the weather data observed at
National Weather Service
locations. A small circle,
known as a station plot, will
appear at each location that
provides data based on the
settings in the display range
and view radius (see Section
4.2.3 for details on setting
display ranges for METARs).
These station plots will be
white, blue, red or purple
depending on the weather
conditions, and will be filled
to various degrees
depending on the amount of cloud cover observed over the station.
The METAR legend, accessible from the Options main menu under the Legends submenu, gives
examples of each possible state that a station plot can have.
Left-clicking a station plot brings up a movable marquee that
provides information about the weather as observed at that
location. This includes the time at which the observation was made,
temperature, dew point, visibility, wind direction and speed, speed
of wind gusts, barometric pressure, precipitation type and cloud
status. A second and additional left-clicks on the same station plot
displays historical station plot information. This action may take a
moment to display. After all of the historical plots have been
selected a full list of historical undecoded METARs will be
displayed. This is only able to be displayed when viewing the latest
observations.
Buoy data is depicted by red and white squares which appear along the coastal areas (and some inland
waters) of the United States. A marquee detailing weather data appears when you left-click these squares.
The data may include the buoy number, the time at which data was last received, the buoy’s latitude and
longitude, the temperature of the air and water along the ocean surface, wind speed and direction along
the ocean surface, wave height, dominant wave period, and air pressure.
When selecting the left arrow of the Obs/Buoy button will display historical observations and buoy data.
As long as your system has been continuously ingesting data the available data to be displayed will be up
to 23 hours in the past. This is both graphical and textual. Select the right arrow to return toward and to
the latest.

4.4.8 Checking City Weather Forecasts
The City Forecast button allows you to check the current days weather forecasts for cities
across the United States. When you click on the button to activate the feature, three-letter
codes for various cities will appear on the map.
Clicking on one of these codes will open a movable marquee that displays the city's forecast for today.
This includes the general weather status—SUNNY, PTCLDY (partly cloudy), SHWRS (showers)—the
predicted high and low temperatures, and the chance of precipitation.
4.4.9 Displaying Satellite Images (Master Mariner Only)
The Satellite button toggles the display of the Infrared Satellite data. The
Infrared Satellite image is developed with an advanced formula that estimates
cloud temperatures at various altitudes across the country and then translates
that into estimated cloud height. Clouds below 5000 feet are so close to
ground temperatures that they are not shown.
As you click the up
arrow button on the
left side of the
Satellite button, the
data displayed will
change to only show
Infrared Satellite at or
above the displayed
elevation, in
increments of 5,000
feet, up to 40,000
feet. Clicking the
down arrow button
lowers the minimum
height down to 5000
feet.

4.4.10 Displaying Fronts

The Fronts button allows you to display surface analysis information. The
current location and forecast locations of the highs, lows, and fronts are
depicted.
As you click the left and right arrow buttons on either side of the Fronts button, the data displayed will
proceed through the available current and forecast surface analysis data. The time stamp in the map
window will display the date and time the data is valid for. The following 5 types of fronts are shown on the
map:
where:
1 == Cold Front
2 == Warm Front
3 == Stationary Front
4 == Occluded Front
5 == Trough

4.4.11 Displaying Areas of Reduced Visibility
(Master Mariner Only)
The Visibility button
allows you to display
areas where visibility
is forecasted to be
less than ideal. Good visibility is considered to be
ten miles or better. When the estimated visibility
drops below ten miles, a contour line appears,
separating areas with different levels of visibility.
The estimated visibility of an area, in miles,
appears on the contour line. As you click the left
and right arrow buttons on either side of the
Visibility button, the data displayed will proceed
through the available current and forecast analysis data. The time stamp in the map window will display
the date and time the data is valid for.
When selecting the left arrow button will display historical visibility data. As long as your system has been
continuously ingesting data the available data to be displayed will be up to 23 hours in the past. Select the
right arrow to return toward and to the latest (Master Mariner only).

4.4.12 Displaying Wind Speed and Direction, Surface Pressure, and Sea Surface Temperature
The Surface button allows you to quickly show the speed and direction of
surface winds, surface pressure, and sea surface temperature. As you click
the left and right arrow buttons on either side of the Surface button, the data
displayed will proceed through the available current and forecast analysis
data. The time stamp in the map window will display the date and time the data is valid for.
The white, arrow-like marks that
appear on the map are wind markers,
which show wind speed and direction
at the location where they appear. The
shaft of the marker indicates the
direction that the wind is blowing. The
barbs along the tail of the shaft
indicate the wind speed: a triangle
indicates 50 knots of wind speed, a
long barb indicates 10 knots of wind
speed, a short barb indicates 5 knots
of wind speed and a straight arrow
indicates less than 5 knots total of
wind speed. Adding up all of the barbs
on a marker gives the total wind
speed. You can also see examples of
each type of barb on the Wind
Legend, which is accessible from the
Legends submenu under the Options
main menu.
The contour lines that appear on the map represent the surface pressure, in millibars. The values of each
contour appear at intervals along the contour line.

The colored areas on the water indicate different degrees of sea surface temperature. As you zoom in
closer, the gradations become finer (moving, for example, from five degree intervals to one degree
intervals). You can click on an area to display text that indicates the temperature for that color shade. The
temperatures are in Farenheight or Celcius depending on your selection in the Units menu (see Section
4.2.5).
When selecting the left arrow button will display historical surface data. As long as your system has been
continuously ingesting data the available data to be displayed will be up to 23 hours in the past. Select the
right arrow to return toward and to the latest (Master Mariner only).

4.4.13 Displaying the Height, Period and Direction of Ocean Waves
The Waves button allows
you to display the height of
ocean waves, as well as
their period and direction. As
you click the left and right arrow buttons on either side of
the Waves button, the data displayed will proceed
through the available current and forecast analysis data.
The time stamp in the map window will display the date
and time the data is valid for.
The colored areas on the water indicate changes in
wave height. The gradations become finer as you zoom
in closer (moving, for example, from 1 foot intervals to ½
foot intervals). You can click on an area to display text
that indicates the wave height for that color zone.
The contour lines on the water indicate areas where the period of time between waves in seconds
changes from the areas around them. A line that reads 6.5, for example, indicates a period of 6.5 seconds
between wave crests for that area.
The white arrows that appear over the water at regular intervals indicate the general direction that the
waves are moving. Each arrow points in the direction of the wave movement in the area immediately
around the arrow.
When selecting the left arrow button will display historical waves data. As long as your system has been
continuously ingesting data the available data to be displayed will be up to 23 hours in the past. Select the
right arrow to return toward and to the latest (Master Mariner only).

4.4.14 Viewing Marine Zone Forecasts (See text for product availability)
The Marine Zones button toggles the display of the Marine zone forecasts. These include the Special
Marine Warnings, Marine Weather Statements, Coastal Waters Forecasts, Great Lakes Forecast,
Nearshore Marine Forecast, Offshore Waters Forecast, Recreational Forecasts and High Seas Forecast.
The first click will bring up the Coastal and Offshore (Master Mariner only) zones, a second click will bring
up the High Seas zones (Master Mariner only), and a third click will bring up the Canadian Zones (Master
Mariner only). Clicking on any zone in the display window will display the associated text for that zone in a
separate pop up window. Use the scroll bar on the side to move through the complete text.

4.4.15 Viewing Canadian Messages
The Canadian
Messages button
opens the Messages
menu, which lets you
view various weather-related alerts for
locations across Canada.
The Locations list in the upper right of
the Messages menu lets you select
the location to browse for messages.
When you select a location, the first
entry in its Categories list
automatically appears in the textbox at
the bottom of the menu. If there are
multiple categories for a location, you
can switch between them by left
clicking on the one you want.
To close the Messages menu, click the OK button or the X button in the upper right hand corner.
4.4.16 Displaying Fish Bytes
Clicking the Fish Bytes button displays icons at
the locations at which various types of fish are
predicted to appear (this is currently available
for the Atlantic and Gulf of Mexico only).
Moving the mouse over one of these icons causes a list of the
fish types predicted for that area to appear in the space below
the map area. Left clicking on the icon causes a similar list to
appear in a marquee on the map area.
Right clicking the Fish Forecast button or selecting the Fish
command from the Setup main menu opens the Setup Fish
menu. This menu allows you to select the fish types you wish to
include in the map icons by checking their respective boxes.
When you have made the changes you want, click the OK
button to close the menu and the fish forecast icons will
automatically update if they are active.

4.4.17 Using SCIT Markers
The white boxes outlined in pink or orange that appear on the
map are known as Storm Cell Identification and Tracking
markers, or SCIT markers. These identify the position of
potentially dangerous storms. WxWorx displays two types of
SCIT markers: Shear Storm markers, which have orange
outlines, and Severe Storm markers, which have pink outlines.
Shear SCIT markers are generated when high wind shear is
detected. This is identified when inbound and outbound winds
are located directly next to each other and exceed a threshold
of 50 knots. Severe Storm SCIT markers are generated based
on the presence of several factors including maximum rain
rate, hail presence, and
hail size.
When you click on a box, a movable marquee appears which
provides details about the storm. Shear SCIT marquees display the
speed of wind shear and the storm width, while Severe Storm SCIT
marquees display the maximum reflectivity, the height of maximum
reflectivity, the projected size of hail suspended in the cell, the storm's
movement, and the storm's width.
As a
result of
processing the data from all of the radars
across the country, multiple SCITs may be
displayed in and around one storm. This is
because each radar with different operational
conditions can provide new and valuable
information on the parameters of a particular
storm cell.
When you zoom in to a map view of less than
188 miles, arrows appear on each SCIT
marker, showing the projected direction of the
storm over the next 15 minutes.
You can toggle off the display of SCIT
markers by deselecting Storm SCITs in the Options main menu. You will notice that the check next to the
command disappears. You can re-enable SCIT markers by selecting the Storm SCITs command again.
The check next to the command should then reappear.

4.4.18 Displaying Wind Speed and Direction (Master Mariner Only)
The Winds Aloft button allows you to quickly show wind information from the
surface to defined altitudes. At a 300-mile View radius and greater, winds are
represented by streamlines, as depicted in the accompanying picture.

The arrows on
each line depict
the direction that
winds are
generally traveling
along that line.
The relative wind
speed is indicated
by the color of the
line with blue as
the lowest velocity
and magenta as
the highest.
At less than a
300-mile View
radius, the
streamlines
become wind
barbs, which show
wind speed and
direction at the
location where
they appear, at
the height
selected. The shaft of the barb indicates the direction that the wind is blowing. The barb along the tail of
the shaft indicate the wind speed: a triangle indicates 50 knots of wind speed, a long line indicates 10
knots of wind speed, a short line indicates 5 knots of wind speed and an arrowhead without any barbs
indicates less than 5 knots total of wind speed. Adding up all of the barbs gives the total wind speed.
The arrow buttons on the Winds Aloft button
allow you to change the height at which winds
are being reported. The available heights range
from winds along the surface to a maximum of
42,000 feet, in increments of 3,000 feet. Clicking
the up arrow or down arrow on the Winds button
will cause the system to automatically display the
winds for the new height.
You can also see examples of each type of wind
barb on the Wind Legend, which is accessible
from the Options main menu under the
Legends submenu.

4.4.19 AutoTrak® Function
WxWorx on Water contains the AutoTrak® Function which has the capability of alerting the user of
projected storm movements. When in GPS mode (see Section 4.5.3), if the path of the boat will intercept
the projected path of a defined storm (SCIT marker), a verbal warning will play over your computer’s
sound system stating, “Attention, you are approaching a dangerous storm.” By interrogating the SCIT

marker (see Section 4.4.17) the user will be able to determine projected storm movement, speed, and
other characteristics of the storm in question.

4.5 Using Options Available with the Mapping and GPS Package (Premium Only)
Depending on the feature packages you have purchased, certain buttons and menu options will be
"grayed out", meaning that you cannot access them. If the Mapping and/or GPS buttons are gray, they
have not been purchased and activated.
4.5.1 Displaying Detailed Mapping and Topography
The Mapping button allows you to switch on and off the display of place names (via the Places Database
settings, see Section 4.5.2), inland water and topography data on the map. If you deselect the Map
button toggles topo option under the Options main menu, the topography will always be off, and only
the place names will switch on and off with the Mapping button.

4.5.2 Setting-Up Your Places Database
The Places Database submenu, found under the Setup menu, allows you to determine the display range
(in miles) of every populated community in the United States. In this manner, you determine at what range
various communities appear on the map when you activate the Mapping button (see Section 4.5.1 for
details). You can also use the Places Database command to add or delete community names from the
database.
The following steps describe how to customize your database:
1. Select the Places Database submenu under the Setup main menu to open the Select State menu.
2. Click on a state name, and click OK to open the Place List for the selected state. Note that all the
populated communities in the selected state are listed alphabetically.

3. Click Add to create a new place, or click an existing place name and click Edit to modify it. The Add
Place and Edit Place menus have identical features. The Add Place feature enables you to add a new
location into your mapping database with appropriate latitude and longitude placement, and requires you
to complete all of the information in the form. The Edit Place option lets you modify information provided
by the system for an already created place. Since almost all community names are included, you will
usually only need to Edit places.
4. Enter the desired parameters on
the Add Place or Edit Place menu.
The following paragraphs describe
each parameter:
Name - Defines the full place name.
Abbreviation - Defines an
abbreviation that can be displayed
instead of the full place name.
County - Specifies the county in
which the place is located.
Population - Defines the known
population, in thousands.
Altitude - Defines the altitude, in
feet, if known.
Latitude and Longitude - Specifies the geographical coordinates. You can automatically assign
coordinates to the place by clicking on the desired spot in your view.
Use abbreviation on map - Displays the abbreviated name, rather than the full place name, on views.
Show Range - Defines the range, in miles, at which the place will display. For example, a place with a
Show Range parameter of 1 will not display until your view range is one mile or less.
Show on maps - Displays the place name on views when it is in range.
Original Data - Reserved for future use.
5. When you are finished adding or editing places, click OK to approve the changes (they are not yet
saved) and return to the Place List, or click Cancel to discard the changes and return.
6. Repeat steps 3 through 5 to add or edit other places in the selected state.
7. Before exiting, be sure to click the Save button, in order to save the changes you have made.
8. Click the Done button to close the Place List. You will have to go through this process again to add or
edit places in another state.
While your Places database contains thousands of place names, you need not adjust them all. The
program defaults all of its communities to a Show Range of 1, which means that a community will not
appear on a map unless your View radius is one mile or less. The only thing you need to do in the Setup
Places operation is to raise the Show Range value for the communities that you want to see at a higher
range.

4.5.3 Using Your Global Positioning System with WxWorx
WxWorx allows you to input data from your GPS data and display your current location as an icon within
the system. The GPS device must be recognized in the Device Manger as a COM Port and use the NMEA
or standard Aviation output format in order to operate with WxWorx.
4.5.4 Setting-Up the GPS and the Display of Boat position
Once your GPS is connected to your display device and the device recognizes the GPS input, you should
configure the display of GPS data on the map using the GPS Settings menu. You can access this menu
through the GPS submenu under the Setup main menu.
When you select the Show vehicle checkbox, a boat-shaped icon representing your boat will appear at
your current GPS coordinates when the GPS button is active.

The Lock mapping view on vehicle checkbox, when activated, causes the system to automatically
center on your boat's coordinates at the current View radius. This can be toggled by the button on the
display.
The Range Rings area allows you to configure the appearance of rings that appear around your GPS
location, defining ranges (in miles) from your vehicle.
The Active checkbox enables rings to display when checked.
The Radius in miles textbox defines the distance between rings, and between the innermost ring and
your vehicle, while the Number of rings textbox defines the number of rings displayed. For example,
setting 2 rings to display at 50 miles each will cause one ring to appear at a 50-mile range from your boat,
and a second ring to appear at a 50-mile range from that ring (100 miles total from your boat).
The Line width in pixels textbox defines the thickness of each ring, with a maximum width of 4 pixels.

The Red, Green, and Blue textboxes (which set the amounts of red, green and blue color, respectively)
combine to give the color for the rings. A value of 255 in all three boxes results in purely white rings, while
a value of 0 in all three boxes results in purely black rings.
The Percentage of mapping behind vehicle controls where the vehicle icon will appear on the mapping.
At 50% the boat will remain in the center of the mapping, at 40% you will have 40% of the mapping behind
the boat and 60% in front of the boat. This allows you to position the boat on the moving map so that you
may maximize the amount of weather viewable in front of your current location when in moving map
mode.
The GPS Com Port Settings area allows you to enter the serial Port number of your GPS, as well as the
baud Rate. The most typical baud rate is 4,800.
The GPS Sim area is used for dealer demonstrations.
You must click OK to approve any changes you make (which also closes the menu) before the new
settings will take effect. Clicking Cancel exits the menu without making changes.
4.5.5 Displaying Your Global Position
Once you have set up and configured your GPS unit, you can make the data appear on
your map simply by clicking the GPS button above the map. When the GPS function is
active, the small area above the map fills with data from the GPS, including your boat's
direction (in degrees), speed (in knots or miles per hour), azimuth of the cursor from your
boat (in degrees) and range of the cursor from your boat (in nautical miles or miles). You
can switch between English and metric measurements using the Units menu (see Section 4.2.5 for
details).
The GPS device must be recognized as a COM Port and use the NMEA output format in order to operate
with WxWorx.

Chapter 5: Frequently Asked Questions
This section is intended to assist you with troubleshooting any problems you may experience with your
WxWorx software and hardware. If at any time during your troubleshooting process you find you are still
experiencing problems please contact our customer support representatives at 256-319-WORX (9679).
1) I get the "GPS error Com X" when I start my application.
2) My antenna signal on the XM Link says >999 on Sat 1, Sat 2 and Ground.
3) The XMLink program doesn't show my radio serial number.
4) I am only receiving and displaying some data products and not all. Some buttons are red and will not
turn blue/green.
5) WxWorx will come up in activation mode when I bring the system back up after not being used for a
month or so?
6) The LED is Green but there is no COM port in the Device Manager?
7) The LED on the power adapter is not lit.
8) What are the power requirements of the Receiver?
9) Does the system come with a Manual?
10) When I call XM to activate my radio I have a hard time getting someone who knows what WxWorx is.
11) How long does it take for the WxWorx to become activated?
12) What GPS’s work with WxWorx and how do I configure the software?
13) Do I need to have WxWorx open to view weather data?
14) How do I fix a “NIP Connect Failed” error in my display software?
15) Can I install the WxWorx software on several different computers?
1) I get the “GPS error com X” when I start my application.
There is either
A) No GPS attached to the display device.
B) GPS does not appear as a Com port.
C) GPS not configured correctly in the Settings->GPS settings menu.
D) Second application running
Case A) Ignore the statement and continue to load the display application. If you are not ever attaching a
GPS then go to Setup->GPS settings and change the port to “0”. This will stop the application from looking
for a GPS when initializing.
Case B) Check your Device Manager to ensure the GPS is a Com port. Go to Start->Control Panel>System. Double click so the “System Properties” comes up, select Hardware Tab, then Device Manager.
Look for the Ports (COM & LPT) and click the plus sign. The GPS should be on one of the listed COM
ports. To verify its operation launch HyperTerminal from Start->Programs->Accessories>Communications->HyperTerminal. Select the COM port that the GPS is connected to and choose the
baud rate you expect the GPS to be transmitting. If no data appears or you can not read the data then
check the cables and settings on the GPS.
Case C) Go to the Setup->GPS settings menu and enter the COM port number and baud rate in the
locations displayed in the popup window. Most handheld or USB-powered GPS units run at 4800 baud
while most Aviation panel-mounted GPS units output at 9600 baud. Bluetooth GPS units can be
configured for several different settings, check the manufacturer hardware to make sure. Once you have
set this correctly then exit this window. A window will pop up telling you to restart the application. Close the
application and re-launch it. The error should not happen again and your GPS button should be blue.
Case D) A second application (ex GPS Viewer, HyperTerminal) is running and has control of the port that
the GPS is connected to. Close the second application and restart the display software. If you are running
two applications that both need GPS input then you will need a second GPS. At present only one

application can access a GPS data source at any one time. There are some third party software packages
that allow a GPS to be shared between two applications but at present we have no recommendations.
2) My antenna signal on the XM Link says >999 on Sat 1, Sat 2 and Ground.
This indicates that you are not receiving any signal from any of the three XM sources. First make
sure you have the latest software version installed. Go to the About menu and check the version number.
Then check the Downloads page at www.wxworx.com/downloads.html to see if a new version is out.
If you are current then within the main Xmlink window under the “Signal Quality” section make
sure that there is not a statement that says “no antenna detected”. If the statement is present then check
the connection of the antenna to the XM receiver. If you do not see the statement then the antenna needs
to be moved to a location where it can see the southern sky. The two satellites are located over the
equator south of Atlanta and Phoenix. Ground repeater stations are only located in large cities to fill the
gaps in coverage due to buildings and other obstacles.
If no antenna is detected or the problem persists then contact WxWorx Customer Support at 256-3199679 and report what you are seeing.
3a) The XMLink program doesn't show my radio serial number.
OR
3b) System was working fine but now it doesn’t find the radio serial number and says sending
power up to radio over and over in the XM Link log window.
This is a communication problem between XMLink and the receiver. To trouble shoot this we will
begin with only the operating system. Begin by closing any WxWorx application and close XMLink. Make
sure it is not minimized in the task bar tray (bottom right corner of most desktops), if it is right click on the
icon (double arrows facing up and down) and select Exit then confirm you want to Exit.
Open the Device Manger to confirm the port is installed correctly. This can be opened either
through Start->Control Panel->System then select Hardware tab and select Device Manger in the middle
right of the window or if there is a My Computer icon on the desktop then right click on it select Properties
and this will bring up the System window as above select Hardware tab and Device Manager. Click the +
sign beside the Ports(COM & LPT). With a USB connected receiver there should be a “USB Serial Port
(COM X)” listed as one of the devices. If not then confirm the following:
a) With the USB cable disconnected from the PC, check that the LED on the receiver is
alternating between bright red and green.
b) Plug the USB cable back into the laptop and ensure the LED becomes solid green.
c) Check the Device Manager for the “USB Serial Port”.
If the computer asks you to load a driver or a question mark appears on a “USB to High Speed
Serial Device” then when the install wizard comes up (either automatically or by right clicking on the device
and choosing update driver) choose the advanced option, in the next window select the browse to a
location and then point the system at C:\Program Files\Common Files\VCP_Drivers directory. The wizard
should then load the correct drivers.
If the LED does not turn solid green or the computer does not recognize the receiver then try only
steps (a) and (b) above on any other computer to confirm there is a problem with the receiver.
If the “USB Serial Port” is present in the Device Manager then try unplugging power to the
receiver. The port should disappear. Wait 30 seconds and plug the power back into the receiver. The port
should reappear, note the number of the COM port. Launch XMLink by itself from Start->Programs>WxWorx on Water (or WxWorx on Wings or Mobile Threat Net (depending on install))->XMLink. Select
from the tools menu “Communications Settings”. Ensure the Com port matches what was in the Device
Manager and the baud rate is set to 38,400 (Portable) or 115,200 baud (Certified).
Another possibility is that sufficient power is not being delivered to the receiver. Make sure that the
power supply in use is either one provided by WxWorx or that it meets the minimum power requirements
(see. What are the power requirements of the Receiver?).
If all of this is set correctly and you still can not communicate with the receiver other problems we
have encountered have been viruses (the MSBlaster virus was a problem), versions of Hot Sync software
used with PDA’s have caused conflicts with COM ports and USB port problems on PC’s.

If the problem persists then contact WxWorx Customer Support at 256-319-9679 and tell them what you
have done to troubleshoot the issue.
4) I am only receiving and displaying some data products and not all. Some buttons are red and
will not turn blue/green.
The receiver may not be fully activated. Bring up XMLink and select Tools->activation mode. Let
the window stay up until the Service Level window indicates the correct package that you signed up for
with XM Listener Care (See Section 1.1). If it does not appear or the Service Level stays as “None
defined” then contact XM Listener Care at 1-800-958-9200 and request a refresh from then. When the
refresh is being sent, leave the receiver in activation mode until the Service Level matches your request,
then click the Done button. The receiver should then begin ingesting all the data products that are part of
your package.
The other possibility may be poor satellite signal strength. Bring up XmLink and check the Radio
status area. You can also go to Tools->Counters and check to see how many errors there have been in
your reception. If there are any errors in the counters window then check your antenna connection and
location.
The last thing is to ensure your computer clock is set properly for time, date AND time zone. The
data is purged from the directory if it is considered out of date and the computer clock is used to compare
the data times.
5) WxWorx will come up in activation mode when I bring the system back up after not being used
for a month or so?
First make sure you have the latest software downloaded from the www.wxworx.com website. Any
version of XMLink greater than 1.23 has addressed this problem. If the receiver has been inactive for
several months then you may need to get a refresh from XM Listener Care at 1-800-985-9200.
6) The LED is Green but there is no COM port in the Device Manager?
This can be caused by various problems. The problem may be related to power. If the receiver
has the correct voltage but not sufficient amperage then when the receiver USB cable is plugged into the
computer it will go from the Red and Green to a solid Green but no COM port will appear in the Device
Manger and there will be NO “Found new hardware” statements. To check if this is an issue, connect the
receiver to a different power source, connect the USB and look for a COM port in the Device Manager.
7) The LED on the power adapter is not lit.
Check the source for the proper voltage (either 12-28VDC or 120 VAC depending on the adapter
in use). If using the car adapter check the fuse in the cigarette lighter. Replace with the same amperage
fuse.
8) What are the power requirements of the Receiver?
Input Voltage
12 VDC
28VDC

Max Current In
400 mA
200 mA

Output Voltage
9 VDC
9VDC

Max Current Out
450mA
450mA

9) Does the system come with a Manual?
Yes, the manual is part of the install and is in PDF format. If you did not say “yes” to place a
shortcut on the desktop during the initial install then you can still access the manual. Go to Start>Programs->WxWorx on Water (or WxWorx on Wings or Mobile Threat Net (depending on install))>(Application type) Users Guide, where application type is Water, Wings or Mobile. The current version
manual is also available on the website (www.wxworx.com) on the downloads page under each
application upgrade section. While there, make sure you have the latest version of the software. The
upgrade will also upgrade the manual on your install if it has changed.
10) When I call XM to activate my radio I have a hard time getting someone who knows what
WxWorx is.

Please make sure you are using the XMWX Weather Satellite activation number 1-800-985-9200
when contacting Listener Care. The operators at this number have been specially trained to handle your
requests correctly.
11) How long does it take for the WxWorx to become activated?
This is dependent on how many XM activations are happening when you call. It can be as short as
15 minutes or as long as 1 hour. If it takes longer than an hour then please call back. Before you call
confirm that the ID in the main XMLink window is the one you are requesting activation for. This ID should
match the one on the box. If it will take longer than 1 hour then the XM Listener Care representative
should make you aware of this when you call.
12) What GPS’s work with WxWorx and how do I configure the software?
WxWorx will accept any GPS that outputs data which is NMEA compliant or aviation standard.
This generally includes all handheld or panel mounted GPS units. The GPS must be visible to the
computer as a COM port. Check with the GPS manufacturer for special cables, connections or setup
options to enable/allow this capability.
Once the GPS is properly configured and connected to the computer then launch the WxWorx
application and go to the Setup->GPS Settings window. Enter the COM port number and baud rate for the
GPS. Close the application and then re-launch it for the settings to take effect.
If you are unsure of the baud rate, then launch HyperTerminal from Start->Programs>Accessories->Communications->HyperTerminal. Select the COM port that the GPS is connected to and
choose the baud rate you expect the GPS to be transmitting. If no data appears or you can not read the
data then check the cables and settings on the GPS.
13) Do I need to have WxWorx open to view weather data?
Yes, the WxWorx must be open, the receiver connected, the antenna must have a view of the
Southern sky and the receiver activated through XM Listener Care.
14) How Do I fix a “NIP Connect Failed” error in my display software?
The display software communicates with the XmLink software via the internal TCP/IP network on
your computer. For the two applications to communicate correctly the TCP/IP protocol must be installed
and active on your computer. If not already installed follow your computer manufacturer’s instructions to
install this protocol on your computer.
If the protocol is already installed and you are still having problems, a second possibility may be a
personal firewall. Please insure that the firewall will allow the two programs to communicate. Refer to your
firewall manufacturer’s documentation for instructions on how to allow this.
15) Can I install the WxWorx software on several different computers?
Both the base software and GPS/Mapping Upgrade can be installed on multiple machines.
However the software will not run if a WxWorx receiver is NOT attached to the computer.

Customer Service
WxWorx software support can be reached at 256-319-WORX (9679), and is offered Monday through
Friday between the hours of 8 AM to 5 PM CST. Additionally, to assist in resolving problems that may
arise we have added a quick troubleshooting guide at the back of this manual. We anticipate that it will
resolve the majority of your questions. For easy reference, if you have problems with non-software related
portions of the XM WX Satellite Weather service please contact one of the following:
XM Satellite Radio Listener Care at (800) 985-9200 for:
- Service activation
- Account management
WxWorx receiver questions can also be directed to 256-319-WORX (9679) or info@wxworx.com.
For questions about other receiver brands, contact the receiver manufacturer. For other software provider
questions, contact your software manufacturer.

Comments
Our goal is to ensure that this document and the software meet your expectations. Please direct any
questions or comments to WxWorx.
info@WxWorx.com
Attn: WxWorx Customer Care
4930 Research Drive
Huntsville, AL 35805
Phone: (321) 751-9202
Fax:
(321) 242-1921

